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7 | 1.0 Introduction

m A oot loci plot is simply a plot of the s zero values and
the s poles on a graph with real and imaginary
ordinates.

m The root locus is a curve of the location of the poles of a
transfer function as some parameter (generally the gain
K) is varied.

m  [he locus of the roots of the characteristic equation of
the closed loop system as the gain varies from zero to
infinity gives the name of the method.

m This method is very powerful graphical technique for
investigating the effects of the variation of a system
parameter on the locations of the closed loop poles.
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m  General rules for constructing the root locus exist and if
the designer follows them, sketching of the root loci
becomes a simple matter.

m  Root loci are completed to select the best parameter
value for stability.

= A normal interpretation of improving stability is when the
real part of a pole is further left of the imaginary axis.
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m Matlab and Root Locus:

= MATLAB Control System Toolbox contains
two Root Locus design GUI, sisotool and
ritool. These are two interactive design tools

of SISO.
Root Locus
Function | Usage Description
pade | [N,D]=pade(tn) Pade approximant
flocfind | [K.P] = rlocfin(system) | Finds root locus gains.
rlocus | rlocus(system) Evans root locus
ritool ool(Plant) nteractive roof locus tool
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m Matlab’s Useful Commands :

m http://courses.ece.uiuc.edu/ece486/docum
ents/matlab _cmds.html

m http://www-
ccs.ucsd.edu/matlab/toolbox/control/refintr
o.html

m http://users.ece.gatech.edu/~bonnie/book!/
TUTORIAL/tut_3.html

The University of Utah



U |2.0 Root Locus Tutorial # 1

m Key Matlab commands used in this tutorial:
cloop, rlocfind, rlocus, sgrid, step

s Matlab commands from the control system
toolbox are highlighted in red.
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m  The root locus of an (open-loop) transfer function H(s) is
a plot of the locations (locus) of all possible closed loop

poles with proportional gain k and unity feedback:
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m The closed-loop transfer function is:

(3 __KH()
R{s} 1-+EHis)

and thus the poles of the closed loop system are
values of s such that 1 + K H(s) = 0.
m [f H(s) = b(s)/a(s), then this equation has the form:
als)+FEs)=0
%+h{3}=ﬂ

m Let n = order of a(s) and m = order of b(s) [the
order of a polynomial is the highest power of s that
appears in it].
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m Consider all positive values of k.

m In the limit as k -> 0, the poles of the closed-loop system
are a(s) = 0 or the poles of H(s).

= In the limit as k -> infinity, the poles of the closed-loop
system are b(s) = 0 or the zeros of H(s).

= No matter what we pick k to be, the closed-loop
system must always have n poles, where n is the
number of poles of H(s). The root locus must have n
branches, each branch starts at a pole of H(s) and
goes to a zero of H(s).
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m Consider an open loop system which has a transfer
function of

_ T(3) g —7

U ofa +5¥a+15Ka +20)

Hys)

num=[1 7];
den=conv(conv([1 0],[1 5]),conv([1 15],[1 20]));
rlocus(num,den)

axis([-22 3 -15 15])



U |2.0 Root Locus Design
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' | 2.0 K from the root locus

m [he plot above shows all possible closed-loop pole

locations for a pure proportional controller.

So use the command sgrid(Zeta,Wn) to plot lines of
constant damping ratio and natural frequency.

Its two arguments are the damping ratio (Zeta) and
natural frequency (Wn) [these may be vectors if you
want to look at a range of acceptable values]. In the
problem, an overshoot less than 5% (which means a
damping ratio Zeta of greater than 0.7) and a rise time
of 1 second (which means a natural frequency Wn
greater than 1.8).
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m zeta=0.7; Wn=1.8; sgrid(zeta, Wn)
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' | 2.0 K from the root locus

m [he plot above shows all possible closed-loop pole

locations for a pure proportional controller.

So use the command sgrid(Zeta,Wn) to plot lines of
constant damping ratio and natural frequency.

Its two arguments are the damping ratio (Zeta) and
natural frequency (Wn) [these may be vectors if you
want to look at a range of acceptable values]. In the
problem, an overshoot less than 5% (which means a
damping ratio Zeta of greater than 0.7) and a rise time
of 1 second (which means a natural frequency Wn
greater than 1.8).
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m [kd,poles] = rlocfind(num,den)
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' | 2.0 K from the root locus

m [kd,poles] = rlocfind(num,den)
m  Select a point in the graphics window
m selected point= -2.6576 + 0.0460i
m kd = 306.9457
m poles =
1) -21.8180
2)-12.5794
3) -2.9373
4) -2.6652



020 Closed-loop response

In order to find the step response, one needs to know
the closed-loop transfer function. [numCL, denCL] =
cloop((kd)*num, den)

The two arguments to the function cloop are the
numerator and denominator of the open-loop system.
You need to include the proportional gain that you have
chosen. Unity feedback is assumed.

If you have a non-unity feedback situation, look at the
help file for the Matlab function feedback, which can find
the closed-loop transfer function with a gain in the
feedback loop.
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m [numCL, denCL] = cloop((kd)*num, den)

m humCL = 1.0e+003*0 0 0
0.3069 2.1486

m denCL= 1.0e+003* 0.0010 0.0400
0.4750 1.8069 2.1486

m >> step(numCL,denCL)
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U rZ.O Root Locus Design
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m Reference:
http://www.engin.umich.edu/group/ctm/rlocus

/rlocus.html

m http://www.cs.wright.edu/people/faculty/kratt
an/courses/414/lab1/matlabcommands.pdf

The University of Utah
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= Design Constraints

= When designing compensators, it is common to have
design specifications that call for specific settling times,
damping ratios, and other characteristics.

m The SISO Design Tool provides design constraints that
can help make the task of meeting design specifications
easier. The New Constraint window, which allows you
to create design constraints, automatically changes to
reflect which constraints are available for the view in
which you are working.
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= Design Constraints

m  Select Design Constraints and then New to open the
New Constraint window, which is shown below.
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s Design Constraints for the Root Locus

m Forthe root locus, you have the following constraint
types:

m Settling Time

m Percent Overshoot
m Damping Ratio

m Natural Frequency

The University of Utah
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Settling Time. If you specify a settling time in the
continuous-time root locus, a vertical line appears on
the root locus plot at the pole locations associated with
the value provided (using a first-order approximation). In
the discrete-time case, the constraint is a curved line.

Percent Overshoot. Specifying percent overshoot in
the continuous-time root locus causes two rays, starting
at the root locus origin, to appear. These rays are the
locus of poles associated with the percent value (using
a second-order approximation). In the discrete-time
case, In the discrete-time case, the constraint appears
as two curves originating at (1,0) and meeting on the
real axis in the left-hand plane.
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s Damping Ratio. Specifying a damping ratio in the
continuous-time root locus causes two rays, starting at
the root locus origin, to appear. These rays are the
locus of poles associated with the damping ratio. In the
discrete-time case, the constraint appears as curved
lines originating at (1,0) and meeting on the real axis in
the left-hand plane.

=  Natural Frequency. If you specify a natural frequency,
a semicircle centered around the root locus origin
appears. The radius equals the natural frequency.
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} SISO Design for System sys_dc
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Right-click on the plots far mare design options.
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m The two rays centered at (0,0) represent the damping
ratio constraint. The dark edge is the region boundary,
and the shaded area outlines the exclusion region. This
figure explains what this means for this constraint.

m Uuse this design constraint to ensure that the closed-loop
poles, represented by the red squares, have some
minimum damping. Try adjusting the gain until the
damping ratio of the closed-loop poles is 0.7.
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m The two rays centered at (0,0) represent the damping
ratio constraint. The dark edge is the region boundary,
and the shaded area outlines the exclusion region. This
figure explains what this means for this constraint.

m Uuse this design constraint to ensure that the closed-loop
poles, represented by the red squares, have some
minimum damping. Try adjusting the gain until the
damping ratio of the closed-loop poles is 0.7.
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= g150t00l

sisotool can also be called with additional arguments. For example. sisotool(Gp), or
sisotool(Gp. Gc). Where Gp 1s the plant object model and Ge 1s the compensator object

model.

You can import SISO LTI model into the Root Locus Design as follows:
¢ Load a model from the MATLAB workspace
e Load a model from a MAT-file
¢ Load the model from the SIMULINK diagram

Similarly, rltool opens SISO Design Tool with only the Root Locus View.

Following examples are used to demonstrate some of the features of the Root Locus
Design.
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In the control system shown G_(s) is a proportional controller, X .

R(s) —~, | 1 C(s)
—( )60 4’{ A T TP %_'

|

Using sisotool determine the following:

(a) Range of K for system stability.
(b) Value of K for the complex dominant-poles damping ration of 0.6. For this value of

K obtain the frequency response GM and PM. Also obtain the step response and the
time-domain specifications.

To make the plant model and start the SISO Design Tool, at the MATLAB prompt type

=>Gp=tf(1l. [1 7 10 0)])
== sisotool
An empty SISO Design Tool opens as shown.
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). SISO Design Tool - 10| x|
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). SISO Design Tool - 10| x|
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The SISO Design Tool has right-click menus available in the plot regions with many

features.
Add Pale/Zero Real Paole
Delete Pole/Zero Complex Pole
Edit Compensator, .. Integrator

Design Constraints  » Real Zero

Add PolefZero
Delete PolefZero
Edit Compensator...

Grid Complex Zero
Zoom ¥  Differentiator
Properties. .. Lead

Lag

Naotch

Real Pole
Complex Pale
Integrator

Real Zero
Complex Zero
Differentiator

Showy

Design Constraints b
Grid

Zoom »
Properties. ..

Right-Click Menu on the Root Locus plot

Lead
Lag
Notch

Right-click Menu on the Bode plot “




(a) To find the value of K for marginal stability drag the closed-loop pole along the
locus to the j@ -axis intersect. Turn on the Mouse Zoom and drag the mouse to draw a

box around the pole. When the mouse is released. root locus will zoom in on the selected
region. Drag the pole to this accurate position. The gain for marginal stability 1s found to

be K_ =70. A zoom out result 1s as shown.
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(b) To find the gain for damping ratio of 0.6. drag the complex pole until the damping
ratio displayed in the bottom panel is in the neighborhood of 0.6. Then zoom in and drag
the pole until damping ratio 1s 0.6. The result is as shown.
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Drag this closed-loop pole along the locus to adjust the loop gain.
Current location: -0.766 + 1.02i Damping: 0.6 Matural Frequency: 1.28 rad/sec
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The gain i1s found to be K; =8.89. Also one of the complex pole and the natural
frequency are displayed in the bottom panel. 1.e.. 5, =-0.766+ j1.02 and @ =1.28 rad/s.
In addition the Gain Margin and Phase Margin are displayed in the Bode plot area., 1.e.,
GM =17.9dB. and PM =58.6".

From Tools Menu select Loop responses/Close-Loop Step to obtain the step response.
Right-click on the plot. and select Characteristics and then Rise Time and Peak
Overshoot. Left click on the blue dots, this will display the time-domain specifications
shown in the Figure below.
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Right-click on the plot areas for more options.

The University of Utah
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Example 2

For the system in Examplel Design a PD compensator C(s) = K, + K ;s for the following

time-domain specifications.

¢ Dominant poles damping ratio £ =0.707
¢ Dominant poles settling time of 7. =2 seconds

[ =4r=2 = 1r=0.5 second

1 - .
Lo, =—= =2.and & =coc I{G.T{]T} =45
r 0.5
Therefore
5 =—2+j2

To make the plant model and start the SISO Design Tool. at the MATLAB prompt type

== Gp=tf(l. [1 7 10 O])
== gisotool
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The University of Utah
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The SISO Design Tool provides design constraints that can make it easier to meet design
specifications. If you want

To place a pair of complex poles on your diagram at a damping ratio of 0.707. select
Design Constraints and then New from the right-click menu in the root locus. This
opens the Design Constraints editor. In the damping ratio field enter 0.707. This results
in a pair of shaded rays at the desired slope. To add a settling time constraint, reopen the
New Constraint window and choose settling time from the pull-down menu, set it’s filed
to 2. In order to have a closed-loop pole at s, =2+ j2, a zero must be added to shift the

loci towards the left-half s-plane. To add a zero. turn on the zeroO on the toolbar and
place the zero ™\ o on the real axis just to the left of the pole with the smallest magnitude.
Move the closed-loop pole up the loci towards the intersection of J and r constraints.
You can turn on the Mouse zoom and place a square in the area containing the controller
zero and the closed loop pole s, . Adjust the zero position on the real axis and at the same

time hold the left mouse and drag the closed-loop pole until the pole is placed at the
desired location as appears on the bottom panel.
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The University of Utah
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To save the compensator design. select Export from the File menu. This opens the SISO
Tool Export. Select Compensator C in the Component column. To change the export
name, double-click in the cell for Compensator C and change the name to say PD. Click
on the Export to Workspace button. Typing PD at MATLAB prompt the PD controller
1s printed.

Zero/pole/gain:

10.0157 (5+2.397)
Thus the PD controller is approximately 24 +10s .

From Tools Menu select Loop responses/Close-Loop Step to obtain the step response.
Right-click on the plot. and select Characteristics and then Rise Time and Peak
Overshoot. Left click on the blue dots, this will display the time-domain specifications
shown in the Figure below.

Also note that the open-loop Bode plot displays the compensated system gain margin and
phase margin.
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Right-click on the plot areas for more options.

The University of Utah



' |3.0 SICO Root Locus Design

Example 3

: : K (s+z
For the system in Example 1 Design a phase-lead compensator C(s) = %
5+ P,

for the

following time-domain specifications.

e Dominant poles damping ratio £ =0.707
¢ Dominant poles settling time of 7. =2 seconds

. =4r=2 = 1=0.5 second

1 _ 5
(o, =—=—=2,and 8 =coc™(0.707) = 45°
) r 0.5
Therefore
Sp=—-2+J2

The graphical root locus is a trail and error procedure. In this procedure we select the
controller zero and we use the given constraints too find the location of confroller poles

and its dc gain. For this example select the zero at —1.75.

To make the plant model and start the SISO Design Tool. at the MATLAB prompt type

:}::stztfll:]_‘ [1 7 10 G']-}
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= g150tool

An empty SISO Design Tool opens. Select Import Model under the File menu. This
opens the Import System Data dialog box. Select Gp and click on the arrow button to
place it in the G field. Click OK. The root locus and open-loop Bode diagrams are
displayed in the plot regions.

To place a pair of complex poles on your diagram at a damping ratio of 0.707. select
Design Constraints and then New from the right-click menu in the root locus, This
opens the Design Constraints editor. In the damping ratio field enter 0.707. This results
in a pair of shaded rays at the desired slope. To add a settling time constraint, reopen the
New Constraint window and choose settling time from the pull-down menu set it’s filed
to 2. Place the curser next to the controller C(s) and click to open its dialog box. In the
Edit Compensator C type —1.75 for a Real Zero. Also. add a real pole. turn on the pole =

on the toolbar and place the pole ™\ x on the real axis to the right of the pole with the
largest magnitude. Move the closed-loop pole up the loci towards the intersection of
¢ and 7 constraints. You can turn on the Mouse zoom and place a square in the area

containing the controller zero. pole and the closed loop pole s;. Adjust the pole position

on the real axis and at the same time hold the left mouse and drag the closed-loop pole
until the pole is placed at the desired location as appears on the bottom panel.
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To save the compensator design, select Export from the File menu. This opens the SISO
Tool Export. Select Compensator C in the Component column. To change the export
name, double-click in the cell for Compensator C and change the name to say PhLead.
Click on the Export to Workspace button. Typing PhlLead at MATLAB prompt the
phase lead controller is printed.

Zero/pole/gain:
64.2588 (s+1.75)
(s+8.023)
64(s5+1.75)

Thus the phase-lead controller is approximately (5+8)
S+

From Tools Menu select Loop responses/Close-Loop Step to obtain the step response.
Right-click on the plot. and select Characteristics and then Rise Time and Peak
Overshoot. Left click on the blue dots, this will display the time-domain specifications
shown in the Figure below.



' |3.0 SICO Root Locus Design

Step Response

Fram: r
14 I I I I I
System: Clozed Loop: rioy
121 Peak amplitude 1.01 u
Owershoot (9T 0559
At time: 1.95
| E4S 4SS EiS S LSS S SIS LSS T e S eI S e e ==
v System: Closed Loop: rta y
Tt T = | Settling Time: 1151
o S':.fsis-sl'(n: Closed i.-:u:up: rioy i =
=z = Rise Time: 0232, )
EL - | | |
I I I
I I I
I I I
I I I |
I I I
l | | LI 1
1 1.5 2 23 3 3.3

Time [(=ec)



U |3.0 Root Locus Design

m Reference: http://www.mathworks.com

= Matlab Help

The University of Utah



' 4.0 GUI for Controls

<} Root Locus Design

File Edit View Insert Tools Window Help

Control Systems

=loix]

Root Locus Design

Enter the numerator and denominator coefficients in descending power of s

Controller Flant
Ris) C(s)
Flant G MMT I '] G (o) Gpls)
Transter Function P den = | [1 7100
Sensor
Feedback path His) num = I (1]
Transfer Function den = I [] His=)

P Controller

Find K to satisty the desired damping ratio

Phase Lag Controller

Design a phase lag controller for the specified damping ratio of
dominant closed-loop poles and ta satisfy the steady-state error

Phase Lead Controller

Design a phase lead contraller far the desired dominant closed-
loop poles

PD Controller

Design a PD controller for the desired dominant closed-loop

Pl Controller

De=ign a Pl controller far the desired dominant closed-loop

PID Controller

Design a FID controller for the desired dominant closed-loop

Info

Exit

Information

Close all Figures and Exit




7 4.0 GUI for Controls

<} Phase Lead Controller Design = |E||£|
File Edit Wiew Insert Tools wWindow Help

Control

Phase Lead Controller Uncompenssted system root-locus

Enter the Enter the
desired Controllat

S R Y

NS T
Find G_c(s)

S|

Imag &xis

Controller: G_(s) = B4(s +1.75/(s +5)
Compensated Open-loop TF

Bds + 112 & &
15% + 1557 + BB + 803 +0 Real &z
Compensated Closed-loop TF
Lisl _ Bds +112

Ri(s) 15% + 1557 +EBe? + 1445 + 112

KG, G, His) =

Roots of the Characteristic Equation:
95311 H0i 242 -2-2i -1.4635 i

System Responzes| Close




U | Concluding Remarks ]

m This tutorial and the GUI for Controls can be
downloaded from

m http://www.cs.utah.edu/~malko/controls/



